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CardWizard for Windows 
NT
In this Chapter

SystemSoft’s CardWizard for Windows NT enables you to use PC 
Cards easily. The user interface provides a graphical view of all PC 
Card slots in your computer and the advanced diagnostic 
capabilities assist you in configuring PC Cards.

Additional features enable you to customize your environment.  
These include the ability to launch applications when cards are 
inserted.

➤ What is CardWizard for Windows NT  1-2

➤ What CardWizard for Windows NT Can Do for You  1-3
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What is CardWizard for Windows NT
CardWizard for Windows NT aids the configuration of PC Cards by 
automatically diagnosing and resolving common PC Card 
problems. 

CardWizard features a PC Card expert system that addresses 
advanced configuration issues.   Insert a new PC Card in a PC Card 
slot and the Wizard pops up a graphical representation of the slots 
and information it gathers about the new card.  If there are any 
problems, click on Wizard and you can automatically fix the 
problem.  Problems like incorrect or missing PC Card drivers, 
system resource conflicts (IRQ, Memory, or I/O ports) unconfigured 
Network and ATA cards, as well as memory conflicts will be 
resolved.

In addition, CardWizard works with PowerProfiler, SystemSoft's 
premier power management solution, and other third-party power 
management systems. PowerProfiler combines highly integrated 
system-level software with a simple-to-use graphical interface that 
delivers unmatched power management capabilities for notebook 
PCs running Microsoft Windows NT (4.0) operating system.

SystemSoft's PowerProfile TM for Windows NT may be bundled with 
your CardWizard for Windows NT product. If these products are 
bundled, you can install both products at once by following the 
Integrated Installation procedure described in Appendix C of this 
user’s guide.
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What CardWizard for Windows NT Can Do for 
You
The CardWizard for Windows NT package extends the PC Card 
support for Windows NT in many ways: 

1 Provides support for cards using existing Windows NT 
drivers.

2 Provides the ability to Hot-Swap Mass Storage (ATA, Flash, 
SRAM), Network, Combos and Modem PC Cards.

3 Supports 16-bit and CardBus PC Cards.

4 Boot-time Support for SCSI and specialty PC Cards 
(nontraditional cards which require their own drivers).

5 Configures PC Cards automatically.

6 Minimizes user intervention in configuring many PC Cards.

7 Provides extensive power management support for PC Cards 
including the ability to enable/disable PC Card slots.

8 Provides extensive Wizard diagnostics, providing the user 
with information about existing problems as well as the ability 
to automatically correct problems. 

CardWizard for Windows NT is easy to use. It lets you view 
information about PC Cards and your computer's PC Card slot(s) 
with a Graphical User Interface (GUI) with features such as 
automatic program launch, Start/Stop functions and Card 
Configuration capabilities. 

❒
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CardWizard for Windows 
NT Installation
In this Chapter

Installing CardWizard for Windows NT
Installing CardWizard for Windows NT is a simple task. Just insert the 
diskette into the appropriate drive and follow the prompts on the screen
you need assistance, refer to the instructions below:

1 If you have any PC Cards currently installed in PC Card slots, 
remove them.

2 If your system is connected to a network, log off before starting th
installation.

3 Logon as an Administrator.

4 Insert the diskette in the drive.

➤ Installing CardWizard for Windows NT 2-1

➤ Uninstalling CardWizard for Windows NT 2-6

➤ Reinstalling CardWizard for Windows NT 2-8
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5 Carefully read the ReadMe file on the installation diskette.

6 Select Run from the Windows NT Start button.

7 Enter a:setup on the Open line in the Run dialog box.

8 Select OK .

Note: This release of CardWizard for Windows NT 
also supports an Integrated Installation program 
which is described in Appendix C. 

The installation program starts and indicates that Setup is 
preparing for the installation.  You will then be guided through 
the installation process.  

The first screen that displays is the CardWizard for Windows 
NT Setup screen shown below.
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9 Select the Next button to display the following Welcome screen.

If Setup detects a previous installation of CardWizard for Windo
NT, it will remove the previous installation and direct you to rebo
the system. See page 2-6 for additional information.

10 The following warning screen displays on your PC.  Remove any 
inserted PC Cards.
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11 In some cases, a screen displaying several computer platforms 
displays (see below). Select the correct computer from this list. If 
your system does not appear in the list, select Other.

12 Select the Next button to display the following Choose Destination 
Location screen.

13 Select Next to install the software in the default destination director
or select Browse to install the software into another directory. If 
Browse is selected, scroll through the folders and select the desire
2-4
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t 
directory. Once the destination directory has been selected, selec
Next to start decompressing and copying the files.

Three different information gauges (upper section of the 
graphic below) provide you with important feedback during 
installation.

Table 2-1 describes the information gauges. 

Table 2-1. Information Gauges

Gauge 
Location Description

Left Indicates the percent of each file 

Center Indicates the amount of the diskette 
that has been transferred to the hard 
disk. 

Right Indicates space available on the hard 
disk - a low sign indicates the hard 
drive has 5% or less space available. 
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t 
The lower section of the previous graphic indicates how much 
of the currently compressed file has been decompressed and 
copied to the hard drive.This example indicates 86% of the 
hard drive is full. 

After all files have been copied, the following screen displays.

14 Before you can run CardWizard for Windows NT, you must 
restart the computer. Choose Yes to restart. 

Uninstalling CardWizard for Windows NT
You can uninstall CardWizard from either the Control Panel or the Star
menu item.

To uninstall this version of CardWizard from the Control Panel:

1 Login as an Administrator.

2 Select Settings from the Windows Start button.

3 Select the Control Panel.

4 Select the Add/Remove icon to display the Add/Remove 
Program Properties window (see the following sample screen).
2-6
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5 Select the CardWizard for Windows NT name, then click on 
the Add/Remove button.

6 A dialog box appears asking if you want to completely remove 
CardWizard and all of its components.

7 Select Yes to start the removal process

8 From the Add/Remove Program Properties window, select 
OK to close the window.

9 The system will automatically reboot with CardWizard for 
Windows NT successfully uninstalled.
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To uninstall this version of CardWizard from the Start menu select the 
following:

Programs > CardWizard for Windows NT > CardWizard for 
Windows NT Uninstallation

The following dialog box displays:

Select Yes to remove CardWizard.

 Reinstalling CardWizard for Windows NT
If you need to reinstall the program, repeat the installation steps which
appear previously in this Chapter. From the Start menu, the Explorer, o
from a command prompt, run setup.exe  on the installation diskette. 

The Setup procedure will detect that you have an active configuration a
will ask you whether you want to proceed. If you select Yes; Setup will 
disable the drivers and the Wizard will instruct you to reboot. (See belo
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The installation program provides a cleanup feature which runs 
automatically during the installation procedure.  If you select Yes, the 
following dialog box displays:

Select Yes to restart the system.

After you have rebooted you can run the installation procedure again.

❒
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NT Features
In this Chapter

This section specifies the features and functions (menu by menu 
presentation) of CardWizard for Windows NT.

Once the installation is complete, you can begin using your PC 
Cards in Windows NT. While your CardWizard for Windows NT 
application includes a comprehensive Help system, this section 
describes many of the practical CardWizard features and provides 
additional hints for CardWizard use. 

CardWizard for Windows NT supports Hot-Swapping of ATA, 
SRAM and Flash PC Cards, Fax/Modem PC Cards, Network PC 
Cards, and Combo PC Cards. Specialty and SCSI PC Cards are also 
hot insertable.   However, some devices need to be available at boot 
to work, therefore we recommend that SCSI PC Cards be inserted at 
boot. 

➤ Features 3-2

➤ The Menu Bar 3-4

Selected Menu Items in Depth 3-6

➤ Power Management Support 3-25

Power Suspension 3-25
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This release of CardWizard for Windows NT supports CardBus 
Cards.   

Features
CardWizard for Windows NT supports a variety of features. 
Table 3-1 provides a description of the features supported in this 
release. 

Table 3-1. CardWizard for Windows NT Features

Feature Description

Hot-Swapping Includes Hot-Swapping of Mass Storage 
(ATA, Flash and SRAM) PC Cards, Network 
PC Cards, and Modem PC Cards. To 
determine if a card supports Hot-Swapping, 
select the Wizard button after you have 
configured the card.

If the card is Hot-Swappable, a screen 
displays indicating that the card has been 
successfully configured and is Hot-
Swappable. (See the sample screen at the end 
of this table.)

Speciality 
Card Support

Specialty cards are PC Cards other than 
traditional PC Cards - and have their own 
drivers. Specialty cards also include 
“Combo” Cards which combine a Modem 
function with a nonnetwork function.

Power 
Management

Allows you to power down (then power back 
to the same state) the entire machine, 
including the PC Card controller, the slots, 
and any PC Cards.

Problem 
Resolution

Helps you to configure the PC Card. You can 
enable AutoCorrrection of problems to 
reduce or prevent the screen messages from 
displaying.

Card 
Information 
Displays

Provides a graphical view of all attached PC 
Card devices. It also provides easy access to 
PC Card settings, configuration items and 
user selected options.
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Stop/Start a 
Card

You must stop a mass storage PC Card before 
removing it. This feature prepares a Mass 
Storage PC Card for clean removal.

Card 
Properties

Provides additional information about a 
specific PC Card.

Formatting 
Memory PC 
Card

Use the FAT file system to format Memory 
(Flash and SRAM) Cards. You can set a 
default drive letter which will be used the 
next time a Memory PC Card is inserted.

User Settings 
for Modem 
/Serial Cards

Allows you to set the preferred order for 
assigning COM ports.

Options for 
Launching 
Applications

Allows you to automatically launch a 
particular application on card insertion. This 
eliminates the need to start the application 
manually.

Sound 
Options

Allows you to associate Sound files with PC 
Card insertion, removal, and Power 
Management events. You can associate 
sounds for up to five distinct events or mute 
sounds. 

Event 
Notifications

Controls the display of card removal and 
insertion dialog boxes.

Card View 
Escape 
Options

Select different methods for viewing 
(numbering and naming) the PC Card 
devices.

Hot-Swap Test Determines if you can safely remove a 
Network PC Card and reinsert it into a slot. 
See page 3-20 for additional information on 
this feature.

Table 3-1. CardWizard for Windows NT Features

Feature Description
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The Menu Bar
The CardWizard for Windows NT application has a single Menu Bar 
(see below) containing File, View, Action, Options and Help items.

The Menu Bar is organized to allow you to easily select different 
views of the application, perform actions against cards, modify 
options, and to obtain help.
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Table 3-2 contains a brief description of each option on the Menu 
Bar. For more detail on these options, see the information on the 
following pages.

Table 3-2. Menu Bar Options

Menu Option Description

File Contains Exit option which enables you to 
exit the CardWizard for Windows NT 
application.

View Toggles the display of the Toolbar and the 
Status Bar.

Actions Allows you to use the Wizard, stop a PC 
Card, display PC Card properties, 
enable/disable PC Card Slots, and format 
Memory PC Cards (Flash and SRAM Cards).

Options Allows you to change card settings, to 
specify the names and the arrangement of 
slots, to setup how messages appear, to 
associate sounds with events (card insertion, 
removal, and power management), and to 
automatically launch applications on card 
insertion. 

Help View the Help Contents, access Help on 
using  Help, display the Topics contained 
within Help, the ReadMe file, and 
information about the CardWizard for 
Windows NT.
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Selected Menu Items in Depth
The following information provides more details about each specific 
menu item.

Actions Menu 

You can access the following features by pressing the right mouse 
button (from the Card Information screen) or by selecting a 
particular item from the Actions menu.

■ Wizard - If you are experiencing a problem configuring your 
PC Card, select the PC Card in question (to activate the Wizard 
button for that card) then select the Wizard button in the Card 
Information window (from the Action menu, or by using the 
right mouse button).

CardWizard for Windows NT then analyzes the computer to 
verify resources are available for PC Card configuration.

Click on the Wizard button to fix most PC Card problems.  
Even if the Wizard cannot automatically resolve a problem, it 
can pinpoint the problem so that you or a technical support 
engineer can fix the problem more easily.    

■ Start - Restarts a stopped PC Card. 

■ Stop - Turns off power to a slot when a card (in that slot) is 
stopped.   Except for Network PC Cards, Stop frees resources 
used by a PC Card.
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■

To stop a PC Card, click on the traffic light on the ToolBar, use 
the right mouse button (and select Stop), or select Stop from 
the Actions menu.

If the card is stopped, the PC Card information screen displays 
a red stop sign.   Once a card has been stopped, the traffic light 
(in the ToolBar) for this card, turns from red to green indicating 
the card is ready to be started. 

Power is turned off to the slot when a card in that slot is 
stopped and it no longer drains power. You must stop Mass 
Storage PC Cards before you remove them. Failure to do so 
may result in unpredictable behavior and/or loss of data.

■ Properties - Displays information about the attributes and 
drivers that are loaded for a PC Card. CardWizard for 
Windows NT extracts important information from the PC Card 
software drivers and lists it here in easy-to-read displays, 
providing a centralized location for all PC Card information.
3-7
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– Attributes tab- displays the following screen for the 
inserted card:

Slot- Indicates the slot this PC Card is currently occupying

Card - Type of PC Card

Manufacturer- Card manufacturer name

Function - Function, for example, Modem, ATA, Flash, 
SRAM, Network etc.

Capacity - Disk capacity for Memory PC Cards (Flash and 
SRAM cards)

File System - File system for Mass Storage PC Cards (ATA, 
Flash, and SRAM cards)

Volume Label - Disk volume for Mass Storage PC Cards 
(ATA, Flash, and SRAM cards)

DOS Device - COM port or the drive letter this device uses

Port - I/O address associated with this device 

IRQ - Interrupt this device uses 
3-8
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– Drivers tab- Displays the following menu:

Name - Indicates the full path to the driver for this PC Card

Version - Indicates the version for the current driver

■ Enable - Allows you to restore power to the currently 
highlighted PC Card Slot.   You can only enable a slot if it has 
previously been disabled.

■ Disable - Allows you to remove power from the currently 
highlighted PC Card slot reducing the drain on the battery. 

Note: .This slot remains disabled even after you have 
rebooted the system. During the period the slot is disabled, 
you can use it as a storage location for any PC Card. 

■ Format - Allows you to format the currently highlighted PC 
Memory (SRAM or Flash) Card. For additional information on 
using Format, see Chapter 5.
3-9
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Options Menu

You can access the following menu items from the Options 
menu: Card Management, Slot Management, Notify, Sounds, 
and Launch.

■ Card Management - Allows you to specify both Modem and 
Mass Storage settings.

– Modem Tab - displays the following menu: 

Preferred Port Order - Allows you to change the order in 
which the Wizard will attempt to assign the COM ports to 
modem PC Cards. For instance, in the example, CardWizard 
will first attempt to assign COM 3 to a newly inserted 
modem. If it is not available, Card Wizard will try COM 4, 
etc.

Auto Configure checkbox - If checked, the Wizard will 
automatically configure modem cards based on available 
resources. Subsequently, it will remember the setting last 
successfully used to configure a modem in each slot.   This 
"remembered" port will be used first when a modem is 
inserted, overriding the preferred order.
3-10
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 If the Auto Configure checkbox is not checked, a Wizard 
dialog box (see below) will appear each time a modem PC 
Card is inserted. 

If the Auto Configure box is checked and there is a resource 
conflict, the Wizard dialog box (above) will also appear. 

Report Conflicts checkbox - Will be disabled unless the 
Auto Configure checkbox is checked. If both Preferred Port 
Order and Report Conflicts are set, the Wizard will send a 
message if it cannot use the "last used" settings because of 
an existing conflict. 

Modems - Provides all information about modems in a 
single location. By selecting the Modem button, you can 
invoke the Microsoft Windows NT Modem Control Panel 
applet and see the modems that are installed. Note that, if 
you need to install a new modem, we recommend that you 
leave “Don't detect my modem; I will select it from a list” (in 
the Install New Modem dialog box) unchecked so that NT 
will attempt to detect the modem.
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Note: .In cases where your system already has a bin modem 
and you are inserting a PC Card Modem, the modem applet 
may not correctly autodetect the second PC Card Modem. In 
this case you must select from the list of supported modems. 

– Mass Storage tab - (See sample screen below.) Allows you 
to set the default drive letter that will be used the next time 
a Mass Storage (ATA, Flash, or SRAM) PC Card is inserted.

■ Slot Management - From this screen you can control the choice 
of First Slot Number (either 0 or 1) , designate the First Slot as 
either the top or the bottom slot, and provide slot names. (See 
the following menu.)
3-12
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First Slot Number - Lets you decide whether CardWizard 
should refer to your first slot as slot 0 or slot 1. If you choose 
to call the first slot "Slot 0" and your computer has two PC 
Card slots, the first slot will be called slot 0 and the second 
will be called slot 1. The default First Slot Number is Slot 0. 
Any changes will take effect once you have pressed the OK 
button.

Slot Representation - CardWizard displays your system's 
PC Card slots one on top of the other.  CardWizard lets you 
decide whether you want the top slot to be your first slot or 
the bottom slot to be your first slot.  The default Slot 
Representation setting is "First as bottom slot".  Any changes 
will take effect once you have pressed the OK button.

Slot Names - CardWizard optionally allows you to assign a 
name for each PC Card slot.  Any changes will take effect 
once you have pressed the OK button.  For example, in the 
screen above, Slots 0 and 1 have been named "BOTTOM" 
and "TOP" respectively.
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■ Notify - Provides information on Enabling Messages and on 
User Message Confirmation. You can use this information to 
control the display card insertion and removal dialogs.

Successful Card Insertion Events: Allows you to select 
whether a message should pop-up when you insert a PC 
Card and it gets configured. When a checkmark is showing 
in the checkbox, a message will pop-up each time a card is 
inserted displaying the name of the card and a graphical 
representation of the card type. To toggle this message 
option, simply click once in the Enable Notification box at 
left. 

Successful Card Removal Events: Allows you to select 
whether a message should pop-up each time a card is 
removed. When a checkmark is showing in the check box, a 
message will appear each time a card is removed from any 
of the PC Card slots in your computer. To toggle removal 
message, simply click once in the option box at the left. The 
change will take effect once you have pressed the OK 
button.

Some possible unsuccessful Card Removal Events which 
would automatically be displayed include:

Removing an ATA or Memory Card (SRAM or Flash 
Card) without first stopping it

Removing a non Hot-Swappable Network PC Card

Removing a SCSI PC Card
3-14
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Notification Message Timeout in Seconds: CardWizard 
insertion and removal messages can be configured to 
automatically disappear after a set time interval.  This 
option allows you to set the duration of all displayed 
messages.  Simply point or click on either the up or down 
arrow to increase or decrease the duration in seconds of all 
displayed messages.  This change will take effect once you 
have pressed the OK button.

Note that when the Power Management system attempts to 
Suspend the system, the Wizard will automatically display 
information about cards in the system. You cannot suppress 
these messages. 

Note: If you have not checked the Enable Timeout box, 
notification messages will remain visible until you clear 
them. If you have checked the Enable Timeout box, Power 
Management events will be timed out. (The default 
duration is 15 seconds and the maximum duration is 50 
seconds.)

■ Sound - The Sound screen (see the following sample screen) allo
you to associate sounds (.WAV files or beeps) with PC Card insert
and removal events. Note that CardWizard automatically grays ou
the Sound menu option if you do not have a sound system installe
3-15
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You can associate sounds with the following:

– Card Insertion, Successful:  The PC Card has been inserted int
a slot and correctly recognized and configured by Card Service

– Card Insertion, Not Configured: The PC Card has been inserte
and recognized; i.e., there is a resource conflict or a lack of 
resources, etc.

– Card Insertion, Unrecognized:  The PC Card has been inserted
but not recognized.

– Card Removal:  The PC Card has been removed from a slot.

– Power Management:  A Power Management event has occurre

To associate a sound file with an event follow these steps:

1 Click on the Browse button and select a sound file (.WAV 
file) for the event you have chosen.  This lets you browse 
for the desired sound file.  Once you have selected a file, a 
Sound Files Selection dialog box will appear.

2 Click on the Test button to listen to the beep or sound 
(.WAV file) before enabling it.  You can test either the exist-
ing (current) file, if one is already present, or the new file 
which you have just selected.  Click on the OK button to 
accept the newly selected file.

3 Click in the Enable box to activate the sound card the next 
time the event occurs. If the Enable box is not selected or if 
a sound card is not present and Event is selected, the 
default beep will occur (for this event) using the system's 
speaker.

4 Click on the OK button to accept the settings and exit.

This dialog box contains the following items. These items will be 
highlighted and available for selection only if they are applicable.

– Enable: Allows you to activate and deactivate PC Card sound 
events. A checkmark indicates that the sound file appearing on
right will play when the associated event occurs.

– Card Events: Allows you to associate sounds for up to five 
distinct events (described earlier).
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– Sound: Once you have chosen a sound (.WAV) file using the 
Browse option, the name and location of the sound file will appe
next to the event under the "Sound File Heading". If the addres
the sound file is long, CardWizard will abbreviate the address s
the most crucial information is displayed. Once you have selec
a file, a Sound Files Selection dialog box will appear. Click on t
Test button to listen to the sound (.WAV file) before enabling it. 
You can test either the existing (current) file, if one is already 
present, or the new file which you have just selected. Click on 
OK  button to accept the newly selected file. Use a sound file 
which is smaller than 180 KBytes. 

– Browse Button - Provides access to files on any of the drives 
available to you. Choose a file that has a .WAV extension (a sou
file) then select OK . 

– Test Button - To listen to a sound (.WAV) file click on the Test 
button.

Note: CardWizard for Windows NT automatically grays out 
the Sound menu options if you do not have a sound card 
installed. 

– Clear Button - Click on the Clear button to erase an entire line. 
Only the highlighted line will be cleared. 

■ Launch - Allows you to associate applications with PC Cards so th
an application will automatically launch when you insert the 
associated PC Card. See the following sample screen.
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Note: CardWizard for Windows NT will only launch an 
application when the associated PC Card is configured. In 
addition, as launching is associated with the current user, 
launching is only possible with PC Cards which are inserted 
after the system has booted and the user has logged on. 

Follow these steps to associate an application with a PC Card for
auto-launch:

1 Highlight a card in the Card List box by clicking on it.

2 Click on the Card button.  The card's name and manufacturer 
information will be displayed below the "Card Name, Manufac
turer" heading.

3 Click on the Browse button and select an application to be 
launched for the card you have selected.  The application nam
and location will appear below the "Application File Name" 
heading.

4 Click on the Test button to verify that you have chosen the righ
application and that it launches properly.

5 Click inside the Enable box to activate auto-launch the next tim
the card is inserted. 

6 Click on the OK  button to accept the settings and exit.

The application will then automatically launch when this PC Card
inserted.

The following items appear in this dialog box. These items will be
highlighted and available for selection only if they are applicable.

– Enable Launch - Allows you to activate or deactivate application
auto-launching for PC Card insertions. A checkmark indicates t
the application appearing on the right will be launched each tim
the associated PC Card is successfully inserted and configured

– The Card Name, Manufacturer - Displays the identity of the 
card which will have an application associated with it.
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– Application File Name - Once you have chosen a launch 
application using the Browse option, the name and location of 
application will appear next to the associated card under the 
Application File Name Heading. If the address of the applicatio
is long, CardWizard will abbreviate the address and display on
the most crucial information.

– Card List Box -Contains the names of all PC Cards that are 
currently installed in your machine. If you remove or insert a ca
while in the Launch dialog box, this box will be updated 
automatically.

– OK Button - Accept the current application launching 
assignments which appear in this dialog box.

– Card Button - If you have highlighted a card in the Card List box
clicking on the Card Button will place the card beneath the Car
Name, Manufacturer heading so you can associate an applicat
with it.

– Browse Button - Provides access to files on any of the drives 
available to you. Select an application and choose OK to selec
The application name will appear to the right of the associated
card beneath the Application File Name heading.

– Test Button - Simulate an auto-launch by clicking on the Test 
button.

– Clear Button - Erases an entire line. Only the highlighted line 
will be cleared.

– Cancel Button - Closes this dialog box without making changes

Help Menu

In addition, CardWizard for Windows NT offers online Help 
designed to make it easy for you to use this product with a 
minimum of effort. The Help menu has the following options:

■ Contents - Select this menu item to bring up CardWizard Help. 

■ Using Help - Select this menu item for comprehensive 
instructions on using Microsoft Windows NT Help.

■ Help Topics - Select this menu item to list all available 
CardWizard Help topics.
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■ ReadMe - Select this menu item to view the ReadMe file 
included with your CardWizard for Windows NTsoftware.

■ About CardWizard - Select this menu item to display the 
version, copyright, memory use, processors and hard disk 
information for CardWizard for Windows NT.

Quick Launch

Once you have installed CardWizard for Windows NT, you can 
Quick Start the application by clicking on the CardWizard icon in 
the System Tray on the TaskBar with the right mouse button. 

This causes the CardWizard menu  to appear on the TaskBar, to the 
left of the CardWizard icon.  Clicking on this CardWizard menu 
once with the left mouse button launches the Wizard application. 

Another way to launch the CardWizard for Windows NT 
application is to double-click on the System Tray icon with the left 
mouse button.

Hot-Swap Capability Test

Many Network PC Card drivers support Hot-Swapping. To 
determine if your Network PC Card supports Hot-Swapping, insert 
the card. The following screen displays: 
3-20



CardWizard for Windows NT Features
Once your newly inserted network card appears,  a Network icon 
displays indicating if the PC Card drivers support Hot-Swapping.  

If the icon has a double arrow (see below), Hot-Swapping is 
supported.

If the icon has a one-sided arrow (see below), run the Hot-Swap test 
to determine if the PC Card drivers support Hot-Swapping.

Select the Wizard Button (which will then be highlighted). You will 
see the Wizard screen.   The Wizard will indicate that it is not sure 
whether the card is Hot-Swappable and it will recommend that you 
select Test to test for Hot-Swap capability.
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Running the Test

Select Test and the following screen displays.:

As the Warning indicates, running this test on some cards may cause 
your system to freeze so you should save any work which is in 
progress before proceeding. 

If your system freezes or your driver does not pass the test, contact 
your PC Card vendor for an updated driver. In addition, you can 
download an updated driver from the SystemSoft home page at: 
http://www/systemsoft.com/.
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To run this test, select the OK button.

To disable the Hot-Swap capability, select the Disable button.  Only 
use this button if you know that a card/driver is not Hot-Swappable 
and want to forego the test and just disable the functionality. 

To exit the screen without running the test, select the Cancel button.

If the Wizard indicates that it is unsure whether your driver 
supports Hot-Swapping or if it was not Hot-Swappable, you can run 
the Hot-Swap test.

Possible Test Results

If you run the test, the following results are possible:

1 Your Network card drivers pass the test and are Hot-
Swappable (see below).

2  When you subsequently insert the card, the following screen 
displays:
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3 Your Network card drivers fail the test and are NOT Hot-
Swappable (see below).

4   When you subsequently insert the card, the following screen 
displays:

5 During the test, you system freezes, indicating that your 
drivers are NOT Hot-Swappable.

6 You get a result indicating that it is uncertain whether your 
drivers are Hot-Swappable (see below).
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Note: Once the test has been run, for subsequent insertions 
the Wizard screen indicates if the card is Hot-Swappable.

If you get an uncertain result, verify that the network is reachable.  
To do this, attempt to view the contents of a file which is stored on a 
network volume.  If you can "see" the network, you should 
manually mark the card as Hot-Swappable by clicking Yes.  If you 
cannot  "see" the network, click No to mark the card as NOT Hot-
Swappable.

Power Management Support
This release of CardWizard for Windows NT provides support for 
Power Management. 

Power Management is used to conserve battery life on a laptop PC. 
Power is conserved by suspending the machine. When suspended, 
many devices are powered off and others run at low power 
consumption levels. When the machine is resumed (exits the 
Suspend state), it returns to the state that it was in before the 
Suspend occurred. Programs and data that were in use before the 
Suspend are restored to their original state. This is done using Power 
Management applications such as SystemSoft's PowerProfiler.

Power Suspension
A system can be suspended as a result of

■ being idle for a specified amount of time

■ the battery power level being below a critical low level

■ the hardware suspend button (on your computer) being 
pressed

■ a software suspend button within a Power Management 
application (such as PowerProfiler) being pressed

 CardWizard assists the user in managing PC Card devices over a 
Suspend/Resume cycle.  The PC Card Controller and the cards are 
powered off as part of a Suspend event.  Each card type is handled 
differently, to prevent losing data or crashing the machine when 
powered off and then back on again.  For example, all files must be 
closed on an ATA disk prior to suspend.
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The CardWizard presents instructions to help you avoid potential 
problems.  The user is expected to follow the instructions before 
allowing the Suspend to complete.  In some cases, the Wizard will 
reject the Suspend event altogether. 

Note that the system can also do a Critical Suspend where the 
system is automatically suspended by the system because the 
battery life is about to expire.  In the case of a Critical Suspend, your 
system may not be able to fully resume to the same state that existed 
prior to the Suspend.  On resume from Critical Suspend, 
CardWizard analyzes the set of cards that were in use at the time of 
the Suspend and presents the user with instructions for saving data 
and preventing system problems.  The instructions may require that 
the user attach AC power and reboot the machine.

Suspend and Resume for Various Card Types

Table 3-3 indicates how CardWizard handles each card type over a 
Suspend/Resume cycle.

Table 3-3. Suspend/Resume 

Card Type
Suspend 
Handling

Resume 
Handling

Resume after 
Critical Suspend

Modem Suspension 
occurs 
(transparent to 
user.)  

Card 
artificially 
removed/inse
rted with the 
same 
configuration.

Card 
artificially 
removed/ 
inserted with 
the same 
configuration.

Network1 System rejects 
suspension.

Not applicable CardWizard 
recommends a 
reboot.

Combo1 System rejects 
suspension.

Not applicable CardWizard 
recommends a 
reboot.
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Mass Stor-
age 
(ATA.Flash, 
or SRAM)

If any files are 
open, the User 
is asked to 
close them.  
Logical disk 
drives 
connected to 
the Mass 
Storage Disk 
are 
dismounted.

Card 
artificially 
removed/ 
inserted with 
the same 
configuration.

Card 
artificially 
removed/ 
inserted with 
the same 
configuration. 
User will 
receive a 
warning that 
data may have 
been lost.

SCSI System rejects 
suspension.

Not applicable CardWizard 
recommends a 
reboot.

Specialty System rejects 
suspension.

Not applicable CardWizard 
recommends a 
reboot.

Other User given 
opportunity to 
accept or reject 
the 
suspension. 

Artificial 
insertion/ 
removal of 
card.Third 
party client 
driver is 
responsible for 
any additional 
configuration. 

CardWizard 
recommends a 
reboot.

1 CardWizard for Windows NT supports Hot-Swapping on Network PC 
Cards and Combo PC Cards. If the drivers for a Network or Combo 
Card are Hot-Swappable, the Suspend/Resume handling is the same 
as it is for Modem Cards. 

Card Type
Suspend 
Handling

Resume 
Handling

Resume after 
Critical Suspend
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From Table 3-3, note that if the user does not respond to a suspend 
dialog within the appropriate time (which is configured from the 
CardWizard Notify Options screen), the Wizard takes the following 
default actions:

■ Hot-Swappable Network and Combo Cards as well as Modem 
and Mass Storage Cards accept Suspend.

■ Non Hot-Swappable Network and Combo Cards as well as 
SCSI and other PC Cards reject the suspension.

❒
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4▼  ▼  ▼  ▼
Hints for Using CardWizard 
for Windows NT
In this Chapter

The following information describes some of the interventions you 
can take to resolve PC Card problems.

Card Recognized but not Configured
 CardWizard has two distinct ways of notifying you when a card is 
configured or not configured. If enabled, CardWizard sounds either 
a single beep or a double beep when you insert a card.

■ A single beep indicates that your PC Card is not configured.

■ A double beep indicates that your card is configured.  

➤ Card Recognized but not Configured 4-1

➤ Card Configured 4-2

➤ Card Recognized and Configured but Doesn't Work 4-2

➤ Suspend Notifications 4-3
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CardWizard also displays very clear messages about cards that are 
in the machine.  

■ If a card is configured CardWizard displays an icon 
representation of the inserted card and tells you the resources 
that have been assigned to it.  

■ An unconfigured card will cause the Wizard to appear with a 
message indicating that the card is "unknown".  In addition, if 
you display properties for this card, a "Warning: Card is not 
configured" message appears.

If a message appears indicating that the card hasn't been 
configured, select the Wizard button and let CardWizard 
troubleshoot the problem. For Network and SCSI PC Cards 
you may need to install appropriate drivers. This may require 
that you have the Windows NT CD-ROM available to 
configure these card and administrative privileges.

Card Configured
You will hear a double beep to indicate that CardWizard has located 
system resources and allocated them to your card.  You can now use 
your card as if it were any other peripheral device.  To view the 
card's configuration, highlight the card, click Actions, then click 
Properties.

Card Recognized and Configured but Doesn't 
Work
If the Card is installed and configured yet does not work, you can 
implement the following courses of action:

■ Modem Cards - ensure that all settings in the Microsoft 
Windows NT Modem Control Panel applet and in your 
communications application correspond and are correct.

■ SCSI Cards- ensure that the proper driver for the SCSI card is 
installed.    

 SCSI PC Cards are hot insertable.  Nevertheless, some devices 
need to be available at boot to work, therefore we recommend 
that SCSI PC Cards be plugged in and turned on at boot 
(especially when the card has already been installed and 
configured, yet does not work).
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Note that some combinations of SCSI controllers and SCSI 
devices do not work together. The reason is that the SCSI 
specification does not specify which device, the SCSI controller 
or the SCSI device, is required to supply termination power.   If 
neither device supplies the power, unusual behavior will 
result. For example, a CD-ROM drive may have many or no 
drivers mapped to it. You can use an Active Termination 
Device to fix this problem.

■ Network Cards - Use the Windows NT Control Panel Network 
icon and make sure that all network components have been 
installed correctly. See Appendix B.

■ Combo Cards - Be sure that the proper drivers for the Combo 
Card have been installed. Reboot the system and then do a hot 
insertion of the Combo Card. See Appendix B.

Suspend Notifications
If you attempt to suspend your system, you may receive a message 
suggesting a required course of action.

■ Modem Cards - None - suspension will occur transparent to 
user.

■ Network - You will not be able to suspend the system while 
there is a Network Card which does not support Hot-
Swapping.  As suspending would make the system unstable, 
you should shutdown your system to conserve power.

■ SCSI Cards - You will not be able to suspend the system while 
there is a SCSI PC Card in use. 

■ Mass Storage Cards - You will not be able to suspend the 
system until you have closed all files and folders on Mass 
Storage (ATA, Flash, or SRAM) PC Cards.

❒
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5▼  ▼  ▼  ▼
Formatting PC Cards
In this Chapter

This chapter describes how to prepare and use removable Mass 
Storage Cards, such as ATA, Flash and SRAM PC Cards. 

➤ Formatting ATA Hard Disk or ATA Flash Disk Cards 5-2

Formatting an ATA PC Card from Windows NT 
Using the Start Button Icon

5-2

Formatting an ATA PC Card from Windows NT 
Using My Computer Icon

5-4

➤ Formatting Memory (SRAM or Flash) PC Cards 5-4
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Formatting ATA Hard Disk or ATA Flash Disk 
Cards
You can use an ATA PC Card like most storage devices. You need to 
format your new ATA card like any hard disk.

You can format an ATA Card from Windows NT using either the 
Start Button icon or the My Computer icon. The following 
information describes each of these methods. 

Formatting an ATA PC Card from Windows NT Using the 
Start Button Icon

1 Select Programs > Administrative Tools > Disk 
Administrator (see below)::
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2 The Disk Administrator will initialize as shown in the 
following sample screen: 

3 From the Disk Administrator Dialog box (see below) you can 
then Partition and either Format or Change Format (from the 
Tools menu) your ATA PC Card:

Once this format is complete, your ATA PC Card should be ready for 
use.
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Formatting an ATA PC Card from Windows NT Using My 
Computer Icon

1 From My Computer, select the icon representing your Mass 
Storage PC Card.

2 From the File menu select Format. The Format dialog box 
displays:

3 Make any desired changes to the fields in the Format dialog 
box.  (Selecting Quick Format will shorten the time it takes to 
format your card.)

4 Click Start to begin formatting the card.

Formatting Memory (SRAM or Flash) PC Cards
A Memory PC Card can be used like most storage devices. You need 
to format your new SRAM or Flash PC Card like any hard disk.
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Follow these steps to format a Memory PC Card using CardWizard:

1 Select Format from the Actions menu after pressing the right 
mouse button (you can also select the Format icon from the 
ToolBar) to display the following dialog box:

2 The following dialog box displays:

3 Make any desired changes to the fields in the Formatting 
SRAM Card dialog box.

4 Click Start to format the card.

❒
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A▼ ▼ ▼ ▼
Accelerator Keys
This appendix describes CardWizard for Windows NT shortcuts.

Table A-1 lists and describes the Accelerator keys for the 
CardWizard for Windows NT application. All Windows NT defined 
keys are also supported. 

Table A-1. CardWizard for Windows NT Short Cuts

Accelerator Menu Item Action

Alt-F File Pop Up File Menu

X Exit Exit the Application

Alt-V VIEW Pop Up the View Menu

T Tool Bar Toggled ToolBar Display On/Off

S Status Bar Toggled Status Bar Display 
On/Off

Alt-A ACTION Pop Up the Action Menu

W Wizard Launch the Wizard

S Stop Stop the Card

Alt-O Options Pop Up the Option Menu

T Setting Submenu

U User User Settings

S Slot Slot Settings
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N Notify Notification Settings

B Set 
Speaker 
Beep 

Toggled Speaker On/Off

S Sound Sound File Settings

L Launch Launch Applications Settings

Alt-H Help Pop Up the Help Menu

C Contents Displays CardWizard Help 
Contents

U Using 
Help

Displays Information on Using 
Windows NT Help

H Help 
Topics

Display Help Topics

R ReadMe Displays the ReadMe File

A About 
Dialog

Display Information on this 
Release of CardWizard for 
Windows NT

Table A-1. CardWizard for Windows NT Short Cuts

Accelerator Menu Item Action
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Network Card 
Configuration 
The information in this appendix explains how to configure 
Network Cards for your PC. 

How to Configure Network Cards
Some Network Cards require the use of Memory windows. The 
location is specified during the network adapter setup. The 
address(es) specified must not overlap with the windows in use by 
other drivers. This can be determined by running NT Diagnostics 
and viewing the memory resources for the PC Card. If a Network 
Card is configured with a conflicting set of resources, the Wizard 
will notify you. Go to the Network Control panel applet to change 
the parameters for the driver. 

Follow these steps to configure a Network PC Card. 
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1 When you insert a Network Card which has not yet been 
configured, the following screen displays: 

2 Press the Correct button.

3 If you have not yet installed Windows NT Networking follow 
the installation from the NT Network Setup Wizard and 
continue with Step 1 when you are required to copy additional 
files.
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4 If you have previously setup a network, the Network 
Identification screen displays: 
B-3
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5 Select the Adapter tab.

6 Select the Add button to view a listing of Adapters.  Then 
either use the adapter driver on the diskette which was 
supplied with your PC Card, or select from a list of adapter 
drivers provided by Windows NT.
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7 If you are using the NT drivers, enter the path to these drivers 
from your Windows NT installation CD (or diskettes). The 
correct drivers will be copied to your hard drive. 

8 The Card Setup screen for your adapter displays on your PC. 
(See an example below.)

9 Confirm that both the IRQ Level and I/O Port Address do not 
conflict with those used by other devices. To prevent a conflict, 
select:

Start > Program > Administrative Tools (Common) > 
Windows NT Diagnostics  
B-5
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10 The windows NT Diagnostic screen displays:
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11 Select the Resources button to view resource use. Then select 
the IRQ button on the bottom of the screen to view the PC 
Card I/O range used by Windows NT. Be sure that your 
Network Card is not using an IRQ used by another device.
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12 Select the I/O Port button on the bottom of the screen to view 
PC Card I/O range used by Windows NT (see below). Be sure 
that your Network Card is not using an I/O address used by 
another device.
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13 Select the Memory button on the bottom of the screen to view 
PC Card memory windows used by Windows NT (see below). 
Be sure that your memory address in the Card Setup screen 
does not conflict with any of the addresses listed in the screen.

14 If you need to provide an IP address for your Network Card. 
Follow the directions from the NT Network Setup Wizard to 
complete your installation.

❒
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C▼ ▼ ▼ ▼
Integrated Installation 
Procedure
The information in this appendix explains how to install 
CardWizard for Windows NT and PowerProfiler for Windows NT 
together.  

How to Install CardWizard for Windows NT and 
PowerProfiler for Windows NT
Installing both CardWizard for Windows NT and PowerProfiler for 
Windows NT together is a simple task.  Just insert the installation 
diskette into the appropriate drive and follow the prompts on the 
screen.  If you do need assistance, refer to the instructions below.

1 If your system is connected to a network, log off before starting 
installation.

2 Logon as an Administrator.

3 Remove all PC Cards from the system.

4 Insert diskette #1 in the drive.

5 Read the ReadMe file on the installation diskette.

6 Select Run from the Windows NT Start button.

7 Enter a:setup on the Open line in the Run dialog box.

8 Select OK.
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9 The installation program starts and indicates that Setup is 
preparing for the installation.  You will then be guided through 
the installation process.

10 The initial Title screen displays, followed by the Welcome and 
Setup screens (see the following three sample screens).
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11 Select PowerProfiler and/or CardWizard to install one or both 
products.
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12 Select the location in which you will install your SystemSoft 
product(s). Both PowerProfiler and CardWizard will be placed 
in subdirectories in the destination location.

13 The Setup program will continue by running the individual 
Setup programs for CardWizard and/or PowerProfiler 
depending upon the programs being installed. You will be 
prompted when to insert a new installation diskette. (Refer to 
Chapter 2 of this user’s guide for CardWizard and Chapter 2 of 
the PowerProfiler User Guide for specifics on the installation 
sequence for each of these products.) Note that some screens 
which appear in the individual installation sequence may not 
appear in this integrated installation.

The System will then prompt you to reboot. Be sure to remove the 
installation diskette before rebooting the system.

❒
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